ST/MDT1-DVP2
Development Kit
User Manual

Release 1.2

June 2001

1S7]

®

Ref: DOC-ST7MDT1-DVP2




INSTRUCTIONS FOR USE—WARNING

This product is conform to the 89/336/EEC Directive. It complies with the ITE EN55022 standard for
EMC emissions and generic 50082-1 (1992 edition) immunity standards.

This product is an FCC Class-A apparatus. In a residential environment, it may cause
radioelectrical disturbances.

In addition, this development board is not contained in an outer casing; consequently, it cannot be
immune against electrostatic discharges (ESD). It should therefore be handled only in static safe
working areas. Please refer to Appendix A: EMC Conformity and Safety Requirements on page 59 for
relevant safety information.

USE IN LIFE SUPPORT DEVICES OR SYSTEMS MUST BE EXPRESSLY AUTHORIZED.

STMicroelectronics PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN
LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF
STMicroelectronics. As used herein:

1. Life support devices or systems are those 2. A critical component is any component of a life
which (a) are intended for surgical implant into support device or system whose failure to
the body, or (b) support or sustain life, and whose perform can reasonably be expected to cause the
failure to perform, when properly used in failure of the life support device or system, or to
accordance with instructions for use provided affect its safety or effectiveness.

with the product, can be reasonably expected to
result in significant injury to the user.
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INTRODUCTION

Thanks for choosing the ST7MDT1-DVP2 Development Kit! The ST7 DVP2 family
of Development Kits offer the following new features:

» Delivered with the debugger software package—ST7 Visual Debug!

« Trace buffer recording, viewing and output.

e In Situ Programming (ISP) ability (for MCUs that support this feature).

This manual describes how to start and use the ST7TMDT1-DVP2 Development Kit
for the ST72254 series MCUs, allowing you to get acquainted with the ST7
microcontroller world and become familiar with the methods for developing and
debugging ST7-driven applications.

If you come across any terms or abbreviations you do not understand, you can check their
meaning in the Glossary on page 65.

This manual also provides a guidance for programming a selection of Flash,
Eprom and OTP (One Time Programmable) ST7 microcontrollers.

The ST7TMDT1-DVP2 Development Kit contains all the necessary resources that
will help you:

e design, develop and debug ST7 application software running in a real
environment,

e program selected ST7 devices in a variety of modes (refer to Table 3 on
page 39).

First off, check that the ST7 MCU that you have picked for your application is in the
list of devices supported by this version of the ST7 MDT1-DVP2:

Supported Devices
ST72254G1
ST72254G2
ST72216G1
ST72215G2

ST72104G1
ST72104G2

ST72251G1
ST72251G2

ST72213G1
ST72212G2

ST72101G1
ST72101G2
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The development kit can be used as a tool to emulate applications on the target
MCU, or as a chip programming tool as summarized in the following sections.

1.1 Development board functional configurations

Figure 1 shows the development board of the ST7TMDT1-DVP2 Development Kit in
an ST7 MCU Emulator configuration. Figure 2 shows the development board of the
ST7MDT1-DVP2 Development Kit in an ST7 MCU Programming Board
configuration.

Figure 1: Using the development board as an ST7 MCU emulator

PC (running
ST7 Visual
Debug)
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application board

Application
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Figure 3 shows how you can set up the development board to perform in situ
programming of devices on an application board.

4
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Figure 2: Using the development board as an ST7 MCU programming board
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Software and documentation for the development kit
The “MCU on CD” CD-ROM contains:

e ST7 Tools, comprising the following software:

The source-level graphic debugger, STVD7, that operates with ST7
Development Kits and ST7-HDS2 Emulators or as a standalone ST7
simulator.

The ST7 Assembly chain, composed of an assembler, linker, librarian and
formatter.

The ST7 Windows Epromer to program your MCU target devices.

e Third-party C compiler and toolchain demos (Hiware and Cosmic).

e ST7 application notes (with sources), training slides and exercises, this manual
(in PDF version), and other useful reference documents in PDF format, such

as:

Datasheets for the ST7 MCU family
ST7 Programming Manual
ST7 Assembler-Linker User Manual

STVD7 User Manual

About this manual....

Detailed instructions on how to install your development kit configuration is
described in Chapter 2: Getting Started on page 11.

How to start debugging your application using your development kit and STVD7 is
described in Chapter 3: STVD7 on page 15.

How to program devices with the development kit is described in Chapter 4:
Programming ST7 Devices on page 39.

The development kit's hardware features are described in Chapter 5: Hardware
Features on page 47.

The following conventions are used in this manual:

Bold text highlights key terms, phrases and is used when referring to names of
dialog boxes, windows and tabs within windows.

Bold italic text denotes menu commands (or sequence of commands),
options, buttons or check boxes which you must click in order to perform an
action.

4
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Getting assistance

For more information, application notes, FAQs and software updates on all the ST
microcontroller families, check out the CD-ROM or our website:

http://mcu.st.com

For assistance on all ST microcontroller subjects, or if you need help with using
your emulator, use the contact list provided in Product Support on page 69. We'll
be glad to help you!
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GETTING STARTED

Your system requirements

The ST7TMDT1-DVP2 Development Kit (both hardware and software components)
has been designed to work with PCs meeting the following requirements:

One of the following operating systems: Microsoft® Windows® 95, 98, 2000 or

NT®.

Intel® Pentium (or compatible) processor with minimum speed of 100 MHz.

Minimum RAM of 32 MB.
21 MB of free hard disk space to install all of the ST7 tools.

Delivery checklist

The ST7/MDT1-DVP2
Development Kit

contains:

1 One development
board (Ref.: MB 269).

2 One parallel cable for
PC connection.

3 One5V external DC
power supply with
female connector
cable.

4 SDIP32 passive
probe (Ref.: DB 382)
and two 34-pin flat
cables.

5 An SO28 probe
adapter (Ref.: DB359)
for user application
connection.

6 One ISP 10-pin flat
cable for in situ programming.

7

8 This manual (not shown).

(1)

(3)

One “MCU on CD” CD-ROM (not shown).
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Figure 4: Development board layout
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Note:
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4

Installing the hardware

To install the hardware, follow these steps:

1 Shut down and power-off the PC that is to be connected to the development
board.

2 Connect one end of the supplied parallel cable to the parallel connector (P2) on
the development board. Connect the other end of the parallel cable to the LPT1
or LPT2 parallel port on your PC.

The supplied parallel cable has been tested in order to operate properly on most PCs. Do not
use any other cable, especially if it is longer than the one provided in the kit—the board may
not operate properly.

The cable should be connected directly to the DB-25 female connector of the PC parallel port.
This connector is similar to the one installed on the board. Do not insert any additional cables
or switch boxes between the PC and the board: a malfunctioning of the board may result.

If a dongle is mounted on the PC parallel port, it should not interfere with the programming
board. Should you notice that the board is dysfunctional, remove the dongle and restart the
installation procedure.

3 Connect the passive probe to J2 and J3 on the development board using the
two flat cables supplied with the development Kit.

4 Plug the DC power supply provided with the Development Kit into a power
outlet. Connect the power cable to the development board. The green Power
LED will light up.

The development board can also be fed via the JP1 connector by an external stabilized power
supply (5 V+0.25V, 1 A) not provided with the Kit.

If the board is fed via the JP1 two-point connector make sure that the right feeders lead to the
right polarities.

5 Power on the PC and proceed with the installation of the software (refer to

Chapter 3 on page 15).
Do not use the jumper connections TP1, TP6 and TP7—they are for factory testing only and
modifications to them could cause your development board to malfunction. See Section 5.2:

Jumper and solder point descriptions on page 47 for more information on the jumpers and
solder points on your development board.
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STVD7

STVD?7 is an integrated development environment that allows you to edit, debug
and rebuild your application all from within STVD7.

The following sections tell you:

Section 3.1—how to install the STVD7 software,

Section 3.2—how to launch STVD7,

Section 3.3—a little about STVD7’s debugging features,

Section 3.4—what a workspace is,

Section 3.5—what toolchains and executable files are supported by STVD7,
Section 3.6—how to create a STVD7 workspace,

Section 3.7—how to open existing workspaces,

Section 3.8—how to open binary files,

Section 3.9—how to change your project settings,

Section 3.10—how to save workspaces,

Section 3.11—how to switch from the build context to the debug context,

Section 3.12—how to configure the target MCU in order to debug more
accurately and efficiently.

Installing STVD7

Your development kit comes with the “MCU on CD” CD-ROM which contains a
number of ST7 software tools. These tools run under the Windows® 95, 98, 2000
and Windows® NT® operating systems.

To install the software on “MCU on CD”, Windows® 2000 and NT® users must have
administrator privileges.

To install and setup the ST7 software tools, follow these steps:

1
2

Close all other open applications on your Windows desktop.

Insert the “MCU on CD” into your CD-ROM drive. The CD-ROM'’s autorun
feature will open up a welcome screen on your PC. If the autorun feature does

not work, use Windows® Explorer to browse to the CD-ROM'’ s root folder, and
double-click on W&l cone. exe.

Select Install Your Development Tools from the list of options. A new screen
will appear listing the different families of STMicroelectronics MCUs.

Use your mouse to place the cursor over the ST7 Tools option. Choose
ST Tools, then ST7 Toolchain from the lists that appear.

15/74
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5 The install wizard will be launched. Follow the instructions that appear on the
screen.

You can choose to install the complete toolchain (i.e. the appropriate version of
STVD7, the Windows Epromer and the Assembler-Linker) for each type of
development tool (Development Kit, HDS2 or EMU3 emulators or simulator), or
perform a customized installation.

If you choose a customized installation, you can choose to install any or all of
the STVD7 versions, and/or the Windows Epromer and/or the Assembler-
Linker. As a minimum, in order to use your DVP, you must install STVD7 for
DVP.

If you also install the ST7 Assembly Toolchain, you will be able to use the ST7
Assembly Toolchain as part of STVD7’s integrated development environment.

The installation is now complete. You will be prompted to reboot your computer.
You should do so before launching STVD?7.

Launching STVD7

1 From vyour Windows desktop, select Start>Programs>ST7 Tool
Chain>Development Tools>STVD7 Development Kit.

2 The first time you open a
version of STVD7 you will be
prompted to enter the
toolchain paths to be used Cosmic builder path:
by STVD7's integrated |CACOSMICIST?
development environment.

Toalchain Path

Hiware builder path:

Enter the paths for the

toolchains that you use (i.e. IEAHIW&HE&PHDG —I
any or all of the Hiware, ST7 Assembler path:

Cosmic or ST7 ASM IE:'\F‘ngram Filez STk st toolchairths | [
toolchains) and click OK.

(The default paths for each

toolchain are shown below.) 0K =]

3 If you choose Cancel, you
will be prompted again to enter the toolchain paths the next time you launch
STVD?7.

You may modify the toolchain path at any time from within STVD7—simply select
Project>Toolchain Paths from the main menu to access the dialog box above.

4
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About STVD7 debugging features

A number of advanced features are included in the STVD7 software:

Data Breakpoints on the occurrence of a memory access via a read operation
or a write operation, or both.

Instruction Breakpoints on the occurrence of an opcode fetch.

A Trace window to view the contents of the trace buffer, which permanently
records in real time on 32-bits:

- Address and data bus information.

- Flag status and 4 external signal values.

You can record up to 256 executed cycles. Using trace filtering, you can filter
out only those cycles you wish to record in the trace buffer. You can equally
control which of the recorded cycles are displayed in the Trace window using
line filtering. Addresses, data, control/status bits and 4 user signals are
displayed using mnemonic and user symbols.

Hardware Events can be used to control the trace recording or the sending of
signals to the trigger outputs.

A powerful online help facility can be invoked at any time to give additional
information about the commands, the processor or the emulator kit.

17/74
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Workspaces

STVD7 organizes project development and debugging into workspaces.
Workspaces allow you to store application and project settings and save them as a
* . wsp file, so that each time you wish to work on the project, you will find all of the
settings exactly as you left them.

Creating a workspace is the first thing that you need to do when using STVD7 for
the first time or when starting any new project. You must have an open workspace
to work with STVD7. How to create a new workspace is described in detail in
Section 3.6 on page 22. Sample workspaces for each supported toolchain are
provided so that you can familiarize yourself with STVD7 (for a listing of sample
workspaces, see Table 1 on page 20).

Each workspace is comprised of three information sets: the project settings, the
visual environment and the debugging context.

e The project settings consists of the information necessary for a successful
build of an application (commands to run, makefile file etc....). Your
workspace’s project settings include the definition of your application toolchain
(see Section 3.5 on page 19).

e The visual environment consists of the open windows elements along with
their current layout, bookmarks and other features. The visual environment is
composed of two environments, one in the Build context and one in the
Debug context (see Section 3.11 on page 31).

e The debugging information includes information on breakpoints, memory
mapping, advanced breakpoints programs, trace etc..

4
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Toolchains and application files

A quick summary of development toolchains and application file types supported
by STVD7 will help you in setting up your workspace.

Three different development toolchains are currently supported by the STVD7.
Each type of toolchain has its own application and executable file types, project
environment and building tools (i.e. linkers and convertors):

The ST7 macroassembler toolchain from STMicroelectronics, which
generates either . s19 or . hex executable files with various intermediate files,
such as . map or. | st files.

The Hiware C or Assembler toolchain, which generates . abs executable
files with various intermediate files, such as . o or . dbg files.

The Cosmic C or Assembler toolchain which generates . el f executable
files with various intermediate files, such as . o or . st 7 files.

When you set up a workspace, you will need to define the following project
settings:

The toolchain to be used— Hiware, Cosmic or ST7 macroassembler.

The executable file (*.abs, *.elf, *.s19 or *.hex depending on
toolchain—refer to Table 2 on page 21).

The maker program for the toolchain. The maker program can be a part of the
toolchain software (such as Hiware’s maker . exe) or you can choose to use a
generic maker such as Nmake. exe or Grake. exe (which is provided with the
STVD7).

The maker batch file (*. nak or *. bat ). This is a file which you create for
each application which spawns the compilation and/or link step each time you
wish to build or rebuild. In it, you define the conditions for recompiling, re-
linking or both.

Default *. mak or *. bat files are often included with the toolchains—for
example, maker.mak is included with the Hiware toolchain and simply
recompiles your application if it detects that the file has been saved since the
start of your debugging session. The STVD7 software includes sample *. mak
and/or *. bat files for each toolchain—these are listed in Table 1.

19/74




3-STvD7

ST7MDT1-DVP2 User Manual

Table 1: Sample files included with STVD7

Toolchain

ST Macro
assembler

Sample Workspace (with
default path

...lrealtimrealtimwsp

Sample Make and/or Batch
files (with default path?)

...lrealtimtimrtc. bat

Description of
Make/Batch File

Batch file that
forces a recompile
of the application.

.../ spiml/spiml. wsp

./ spimll/spiml. bat

Batch file that
forces a recompile
of the application.

Cosmic

...lclcosmc/sanpl e.wsp| ..

./ c/cosm c/ sanpl e. mak

Recompiles only if
one (or more) of

the application files
has been resaved.

./ c/cosm c/ sanpl e. bat

Batch file that
forces a recompile
of the application.

Hiware

... /Iclhiware/sanpl e. wsp

./ ¢/ hiware/build. mak

Recompiles only if
one (or more) of

the application files
has been resaved.

./ c/ hiware/rebuil d. mak

Forces a recom-
pile of the applica-
tion.

1) The full default path is: C./ Program Fil es/ St m st 7t ool chai n/ stvd7/
dvp/ sanpl e/ . ..

3.5.1 About executable files

The user should verify that the options to include debug information were active
during creation of the project files. Table 2 on page 21 summarizes the way each
toolchain functions and lists the different file types (source files, intermediate files
and executable files) used and produced by the toolchain. The executable file
types and intermediate file types necessary to exploit fully the STVD7
capabilities are listed.

20/74
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Table 2: Toolchain steps and their output files

Toolchain: ST Macroassembler Hiware Cosmic

Compile or Assemble Step:

Source File .asm .C, .asm|.c, .s
Types
Required asm-li macrost7.asm <NONE> +debug
Options
Resulting File | . obj, .l st .0, .dbg |.o0
Types

. _______________________________________________________________________________________________|
Linker Step:
Required lyn macrost7.obj, macrost? <NONE> <NONE>
Options asm macrost7.asm -sym -fi =macrost 7. map
Resulting File | . map, .| st . abs .st7
Types

. ____________________________________________________________________________ _____ __________|
Converter obsend macrost7, f, macrost7.s19, srec not cvdwar f
Step: or applicable

obsend macrost7, f, nmacrost7. hex, intel

Resulting .s19 or .hex . abs, .elf
executable .elf
file:

. ____________________________________________________________________________ _____ __________|
Necessary .map, .Ilst .0, .dbg | <NONE>
Intermediate
Files:

The executable file(s), source files and any necessary intermediate files (these
are listed above and contain debug information necessary to the STVD) should be
located in the same project directory. You do this when you define your workspace.

Note: It is always preferable to have access to all of the files generated by the development
toolchain. However, you can load *.s19 or *. hex binary files directly and have limited
debugging capabilities (refer to Section 3.8 on page 26).
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Creating a workspace

1 Select File>New Workspace. This command opens a new window where you
define the name of your workspace and the directory in which you want to work.

Hew Workspace Ed |

Wiorkzpace filenarme:

Im_l,lw::urk]

Wiorkzpace locatian:

IE:'\F’mgram FilezhS T st toolchain®, _I

Mewt »

Cancel

4
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4

2 Then, click Next>. The New Workspace: Project Settings dialog box

appears:
New Workspace: Proect Settings G|

Woorkspace filename: I Comy vk mnpwiork. wep
Software Toolchain: IST.'-" Hiware Toolchain j

 Executable
Filenarne: Isample"m'xhiware'xsample.al:us _I

— Build
taker: I Hiwsare mak.er j
bdaker filenanne: |D:"~HIW.&F|E"\F'FIEIG"«maker _I
takefile or batch file: |$ample"u::"-.hiware"-.l:nuild.mak _I
"Build" cormmand line: Imaker build. rak
"Rebuild A" commmand line: |maker rebuild mak
Start "Build" # "Rebuild A" i ISEII'I'II:I'EI'\C"'.hiWETE _I

< Back. Einigh Cancel

Here you enter your software toolchain, your executable filename and your
build parameters either by typing or using the drop boxes.

Select the toolchain and enter the name of your application’s executable file.
For example, if you wish to use the Hiware toolchain for ST7, your executable
file will be of type *. abs (refer to Table 2 on page 21)—click on the browse

button | to browse to the folder where your executable file is saved and
select it.

Next, choose the type of maker your application uses from the drop down list. In
the example above, we have chosen the default Hiware maker, naker . exe.

STVD7 will automatically look for this maker file in the folder you defined as the
Hiware toolchain path.

Finally, you must define a make file or a batch file. There are several sample
files provided with STVD7 (see Table 1 on page 20). Here we have chosen
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bui | d. mak as the default make file, used when the Build command is issued,
and r ebui | d. mak as the make file to use when the Rebuild command is
issued.

6 After you have finished defining your project settings, click Finish.
Once the workspace is opened, the Workspace window displays its contents.

When you create a new workspace, the first time you switch to Debug context (see
Section 3.11 for an explanation of STVD7 contexts), the MCU Configuration
window will automatically open to prompt you to choose you target MCU and
confirm or modify its option and memory configuration (see Section 3.12 on
page 32).

Opening an existing workspace
If you have already created a workspace, you simply need to open it in order to
load all of your project settings into the STVD?7.

There are a number of sample workspaces provided with STVD7 that you can open to get
familiar with STVD7. These samples are listed in Table 1 on page 20.

1 From the main menu, select File>Open Workspace.
This command opens a window where you can browse to any folder you wish,
and select an existing workspace.

OponWorkspace ____________HE|
Look in: IaDebug j | ﬁil e |
Dsample

My v ark s

File narme; || Open

Files of wpe: IST? Project Workzpace [*.wsp) j Canicel

4
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Note:

4

2 The Workspace window opens.

2=l
When a workspace is opened, all = Hgsl mywork.wep
of the predefined project settings El B samplebethivarehbuild mak
are loaded into the STVD7. The -~ [ sampletcthinaretsample. abs

Workspace window will show a
structured representation of the
project. For example,
mywor k. wsp shows that it uses
bui | d. mak as the make file and
sanpl e. abs as the executable
file.

Although the name of the executable file
is shown in the Workspace window, it has
not yet been loaded into the emulation
memory—see page 26.

If you click on the Source 5] Workspace 3y Sauree Directo...
Directory tab, the window will

show every source and intermediate file type (*. ¢, *. s,*.asm™*. hor*. 0) in
the selected directory.

=l
=gl C :“Program Files\5 Tk et Ptoolchain's
zamplel.c
zampleZ. azm
zampled.c
start]?.c
gtartdy.h
-1 Double click here...
1 | il
@ Workspace () Source Direct... |-

3 If there are no source files shown in the Source Directory tab of the Workspace
window, or you wish to list additional files stored in another folder, you may
browse to them by clicking the Double Click here... folder. The Add Source
Directory window pops up allowing you to enter or browse for a new directory,

25/74




3-STvD7 ST7MDT1-DVP2 User Manual

and filter out the file types of interest. You may also choose to specify a
directory that is relative to the workspace directory by clicking on the Path
relative to the Workspace directory option.

=
=L C:vProgram Files'

zamplel.c

I

samnple2. asm
sampled.c
shartdy.c

startly h

Double click here

Add Source Directory [ x| |

[T Path relative ta the Workspace directon

Fath: D:hzampleshsampled |

Filez filker: I".n: Fhamm Foe finc® eppt bat T|

Ok Cancel

<

Elnior... 1) Sou... |

4 To load the executable file, as well as any intermediate files, click the Debug
icon or the Reset Chip icon. The application and symbols will be loaded. Before
you can start debugging, you must set the target hardware device by
configuring the MCU.

3.8 Opening binary files

If you do not have access to the source or intermediate files generated by a
toolchain, you may also load *. abs, *. s19, *. hex or *. el f files on their own
using the Open Workspace command.

Note: The range of debugging features available when you open a binary file only will be very
restricted. You will only have access to basic debugging windows, such as the Disassembly
and Memory Windows.

1 Launch STVD7 and select File>Open Workspace from the main menu.
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3.9

4

2 Browse to the folder where your binary file is stored, and select ST7
Application files (*.abs, *s19, *.hex, *.elf) in the Files of type field.

DpenWokspace G
Lack jr: I'al'ﬂ.'r'_wmk j El

Filename: [ 5T7 Application files [%.abs:519:% hew." ] gpen |
Filez of type: I.-'-‘-.II files [*.7] j Cancel |

3 Select your binary file (*. abs, *. s19, *. hex or *. el f) and click Open.

The binary code in the executable file will be loaded into STVD7 and you will be
able to access the Disassembly Window. A workspace file (of the same name as
the binary file, but with an extension . wsp) will be created automatically.

Changing your project settings

The Project menu contains the Build and Rebuild All commands you need to
recompile your application after having made changes to it in the course of
debugging. You may also access your project or toolchain settings in the event you
wish to change them.

| Froject

(] Build F7

Riebuild All

StopiBuid

Project Settings... Alt+F7F
Toolchaing Path...
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From the main menu, select Project>Project Settings.
Project Settings Ed |
Wiorkzpace filename: whzrchatedebugh D ebugt samplehchzample, wap
Software Toolchain: IST.'-" Hiware Toolchain j
— Executable
Filenarne: Isample.abs _I
~Build

b aker: IDther maker j

b ak.er filename: IE:"-.HIWI—‘«FIE"-.F'FIDG'\Maker.EHE _I

b ak.efile; Igamp|e_mak _I

"Build" command line: IMaker.e:-:e sample.mak

f.'FIeI:nuiId A" commatd IMaker.EHe samnple.mak

_Stf”t "Build" / "Rebuild A" IE:Wiew'w::ul:u'xgui'xstvd'xsrc'xstvdebug'\[)e _I

ok Cancel
You can change your settings here and continue running your application. When
you exit STVD7, the system will ask you if you want to save these settings in the
workspace you have been working in. If you choose yes, these will become your
new workspace settings; if you choose no, these settings will be lost.
28/74 [71
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The Toolchain Path... item invokes the following window:

Toalchain Path x| I

Cogmic builder path:

|CACOSMICIST?

Hiware builder path:
IE:'\HIW.&FHE'\F'FHEIG

ST Azzembler path:
II:: WProgram FileshS Th st Proolchainhz

amreennney

k. Cancel

In this window, you can define your builder and/or Assembler paths. Clicking _I
opens a browser window.

3.10 Saving workspaces

Whenever the current workspace is closed, it is automatically saved. This can
happen either when exiting STVD or opening or creating a new workspace.

In addition to this, a workspace can be explicitly saved with the File>Save
Workspace... or File>Save Workspace as... commands.

The user is given the choice of which of the workspace elements to include in the
saved file. Either the visual environment or the debugging information may be
saved alone, or both may be saved together. This is configured as follows:

1 From the main menu, select Tools>Options.

2 In the Options window that opens (see Figure 5 on page 30), select the
Workspace tab.

3 Choose whether you wish your saved workspace to include either the visual
environment or the debugging information or both.

4
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4 Select which windows will appear docked when a project is opened by checking

the appropriate check boxes in the Floating windows in the main frame area.
Only windows currently docked in the main window can be included.

T T
Tn:n:nll:narsl Enmmandsl Edit/Debug ‘Workspace |

Floating windawsz in the main frame:
Wiorkzpace includes:

O utput ¥ Wizual environment
Dizazzembly
b oy
Inztruction Break points
Watch
Call Stack,
Local W ariables
STY Data Breakpoint:
STY Reqisters
STY Penipheral R egisters

¥ Debugging context

] I Cancel SEpl

Figure 5: Options window

1 Click Apply to confirm your settings.
2 Click OK close the dialog box.

In addition, open file contexts and current window positions are saved when the
workspace is closed. This feature restores the workspace window, window layout
and file views to that which was current when STVD7 was closed. The toolbar
layout, plus customized toolbar content is also saved and restored with the
workspace (options set via the tabs entitled Toolbars and Commands).

By default (i.e. when saved automatically) the workspace is saved as file
<application>wsp. The name of the file corresponds to the name used for the
executable file (for example, <application>.abs for a Hiware executable file).
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Note:

3.11

3.11.1

3.11.2

4

Using the Configuration Setup dialog box (available from the MCU Configuration dialog
box), you can also control what type of MCU configuration information is restored from a
workspace file (*.wsp).

Debug context and Build context

There are two STVD7 contexts, the build context and the debug context. Until
now, in creating a workspace, and defining your project settings, you have been in
the build context. To proceed step—configuring your MCU—you need to change to
the debug context.

Briefly, the two contexts are different in that:

e In the build context, you can open and close workspaces and build or re-build
the application executable file.

e In the debug context you set the emulated MCU configuration (this step is
described in Section 3.12 on page 32) and debug the executable file created
while in the build context.

Build Context

The build context is the context set when starting STVD7. In this context, it is not
necessary to be connected to a development kit and the debug commands are not
available. You can also edit the source files of an application and perform the use
the Build command to perform compile and link actions in an interactive and
iterative way to re-build the application executable file.

Debug Context

In this context, the following debug actions can be carried out:

« Loading, running and stopping the application.

» Defining the MCU configuration (MCU options and memory mapping).
* Viewing source and disassembled code.

e Setting instruction breakpoints with a counter and/or condition.

e Setting data breakpoints.

* Viewing local variables, memory and ST7 registers.

« Viewing history of execution from the trace buffer or with the Call Stack feature
analyzing the performance of a piece of code.
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3.11.3

3.12

Note:

32/74

Switching between contexts

The switch between contexts usually occurs when the Start
Debugging and Stop Debugging commands are used:

©

From the main menu, choose Debug>Start Debugging or
Stop Debugging or click on the Start Debugging or Stop

Debugging icons shown at right.

While debugging, the editor allows source files to be
modified. To switch to the Build context perform either a
Build or Rebuild action or use the Stop Debugging
command.

©

Stop Debugging

Configuring the MCU

After you create or open a workspace, the next step you must perform before
starting your STVD7 debugging session is to define and configure the target device
(MCU) that you wish to emulate.

The target device is defined and configured from the MCU Configuration window.

1 First, ensure that you are in Debug context by clicking on o . (STVDY has
two contexts: Debug context and Build context—these are described in
Section 3.11.)

The first time you enter into the Debug context after having created a new workspace, the
MCU Configuration window will be opened automatically.

2 Select Tools>MCU Configuration from the main menu. The MCU
Configuration window will open.

4
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An example of a typical MCU Configuration window is shown in Figure 6.

MCU Name field

MCU Configuration - ST7ZXX XXX

—Zoom

MCU name: [gT7XXXXX vI From [ To Type | il Selection auto zoom [V
0x0000 | 00002 | PERIPH Sy TEMEZ [0:0100

Option Valie [ | 0x0003 | 0x0003 | RESERVED M,Fm—

LVD_5 V.. | OFF 0x0007 | 0x0007 | RESERVED RESERVED

CLOCK Fl_ | OFF 0x0008 | 020005 | PERIPH 0400c0

BT T TOPAAT | | 0x000b | 0x001f | RESERVED

CLOCK ON_BOARD | | 00020 | 0x0026 | PERIPH

e A
I l e

HALT_AN.. | RESET 0x002f | 0x0030 | RESERVED kil 1963548
0x0031 | 0x004f | PERIPH

0x0050 | Ox006f | RESERVED
0x0070 | 0x0071 | PERIPH

0x0072 | 0x007f ESERVED Lt
0%0080 | 0x013f r}%:
0:0140 | 0x017f | STRCK
0:0180 | Oxdiif | RESERVED E&M spuhss |
n:ann n:rmf nniiﬁ S
0K | Cancel | Conf... | Insert | / iy | Delete
/
Option configuration Memory configuration Graphic memory
fields fields configuration viewer
Figure 6: MCU Configuration window
Note: The options shown in the above example may not be available for your particular target MCU.

3 Set the Target MCU. In the MCU name field, select the target device for which
the application is intended from the dropdown box. Once a target MCU has
been chosen, the Option configuration and the Memory configuration fields will
show the default values for this device.

4 Configure the MCU Options and On-Chip Peripherals. All of the
configurable options on your target hardware device are listed in the Option
configuration fields. Beside each option, a default value is given. You may
change this value by clicking on it and choosing a new value from the drop
down list. This allows you to configure your target device’s options and on-chip
peripherals. Depending on the MCU selected, the default settings in the Option
configuration fields will change. It is up to you to configure those options that will
impact your application so that the development kit accurately emulates your
target device.

4
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Note:

For more information about the configurable options available on your target hardware
device, please consult your target MCU'’s datasheet.

5 Configuring the MCU Memory. The default memory settings depend on the
MCU selected. However, you can configure the memory settings as you wish if
your application requires non-default settings. This feature would enable you,
for instance, to temporarily increase the ROM size during the development
phase of your application.

—£anm

From To Type | |11 11 il LI Selection auto zoom [
0+0000 | 0x003f | PERIPH ATz T
0x0040 | Dx00F | R Lee2s SYSTEM LSS
Os100 | O3 | STACK EEE
0x0150 | Ox0eff | RESERVED
04000 | DxOFF | SYSTEM aeEd L
041000 | Oxeff | RESERVED
04000 | Owffidt | ROM
Oxffed | Oufff | VECTORS i~
0x4000

Cont... | [nzert | / [ mliy | Delete

/
0003 H

\

Memory Graphic memory
configuration fields configuration viewer

There are two methods for configuring the memory settings on the MCU: by
typing in the start and stop addresses of each memory zone into the memory
configuration window, and by graphically moving the memory zone
boundaries in the graphic memory configuration viewer (see page 36 for
more instruction).

Memory zone types

34/74

The left column of the memory configuration window indicates the address
range of each memory zone. The right column indicates the memory type of each
zone. Depending on your target MCU, the available memory types may be:
Peripherals, RAM, ROM, Stack, System, EEPROM, Reserved, Vectors,
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4

Application. Some of these zones can have their type and size modified, others
cannot be modified. Their definitions and properties are explained as follows:

Peripherals: Microcontroller internal or rebuilt peripherals registers. Their
properties are defined as in the microcontroller datasheet. This memory
cannot be modified.

RAM: Random-Access-Memory of the microcontroller. This memory type can
be modified.

ROM: Read-Only Memory of the microcontroller. Write protected. This memory
type can be modified.

Stack: Stack of the microcontroller. This memory type cannot be modified.

System: The development kit uses this space for emulation management. This
memory type cannot be modified.

EEPROM: This memory is internal to the microcontroller and is located inside
the emulation device. The programming of this zone is done according to an
automaton found in the datasheet. This memory type cannot be modified.

Reserved: This memory zone is reserved as on the microcontroller. It is not
allocated to any use and is write protected. This memory type cannot be
modified.

Vectors: This memory zone contains the user interrupt vectors zone. It is write
protected. This memory type can be modified.

Application: This memory type is microcontroller-specific. The user can add
memory or peripheral resources on its hardware. It is not available on every
development kit. Properties are linked to the user hardware. This memory type
can be modified.

For most target MCUs, you may modify the following types of memory zone: RAM,
ROM, Reserved and Application. This feature would enable you, for instance, to
temporarily decrease the RAM zone, increase the size of the ROM (to exceed what
is available on the real microcontroller) during the first stages of development.
Once your program is functional, you can start to optimize its size by reducing your
code and returning these zones to their original size. There are two different
actions you may perform on the memory configuration:

change the type of an entire existing zone.

define a new zone of any type wherever possible.
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To change an existing memory zone:

1
2

Select the memory zone to be modified.

Click on the Modify button at the bottom of the window. A New MCU Memory
Range dialog box will open, allowing you to change either the address range
and/or the memory type of the memory zone.

Mew MCL memory range

Fram IEIHEIEIEEI To IEI:-:EH 3

Type:  |Rab j
PERIPHERALS

OfSTACK Cancel |

EFR
EEF
WECTORS

To create a new zone of any type:

1

2
3
4

Click on the Insert button. The New MCU Memory Range dialog box will
appear.

Enter the address range of the new memory zone in the From and To fields.
Select the type of the new memory zone in the Type field.

Click OK to validate your choice.

The new memory zone will then appear in the MCU Configuration window unless
you tried to create a new zone in a nhon-modifiable memory space (such as Stack
or EEPROM).

To use the Graphic Memory Configuration viewer:

36/74

1

In the memory configuration window, click on the zone whose boundaries you
wish to move.

Check the Selection auto zoom box in the upper right-hand corner. The
graphical view of the memory configuration will be scaled so that the zone you
have selected is easily visible.

At the upper and lower boundary of the zone, at the left-hand side of the
graphical viewer, you will see a small triangle and rectangular box giving the
boundary addresses of the memory zone. You can change a boundary address
by dragging and dropping the triangle with the mouse to its new location. The
triangle can be moved either up or down, left or right in the graphical viewer.
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3.13

4

The MCU configuration that you specify will, by default, be saved in a workspace
file (*. wsp) for the project. The next time the application is opened, the STVD will
automatically set the MCU configuration (as well as the layout of opened windows
and other debug information) to the same conditions you had when you left the last
debugging session.

If you do not wish your MCU configuration information to be saved in the
workspace file, you must alter the default Configuration Setup options by clicking
on the Conf... button.

Start debugging!

Once in debug context, you are now ready to start debugging your
applicationusing the development kit. Full documentation on how to:

e control your STVD7 work environment
e use its integrated editor
e use the many debugging windows and features

is available from the online help and the online STVD7 user manual, located under
Help in the main menu.
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4 - Programming ST7 Devices

PROGRAMMING ST7 DEVICES

Once bug-free and ready for operation, your application program needs to be
transferred into an ST7 MCU program space.

With the ST7TMDT1-DVP2 Development Kit, you may program the MCUs shown in

Table 3.

Table 3: Programmable Devices

Supported Device

Device Group

Programmable Memory

Programming

Typel Method(s)?
ST 72254 G1 Group 1 EEPROM ZIF Sockets3 and ISP
ST 72254 G2 (based on ST72254)
ST 72216 G1 Group 1 EEPROM ZIF Sockets and ISP
(based on ST72254)
ST 72215 G2 Group 1 EEPROM ZIF Sockets and ISP
(based on ST72254)
ST 72104 G1 Group 1 EEPROM ZIF Sockets and ISP
ST 72104 G2 (based on ST72254)
ST 72251 G1 Group 2 EPROM and OTPROM ZIF Sockets
ST 72251 G2 (based on ST72251)
ST 72213 G1 Group 2 EPROM and OTPROM ZIF Sockets
(based on ST72251)
ST 72212 G2 Group 2 EPROM and OTPROM ZIF Sockets
(based on ST72251)
ST 72101 G1 Group 2 EPROM and OTPROM ZIF Sockets
ST 72101 G2 (based on ST72251)

1) For more information about the programmable memory for each target device, refer to the
target device’s datasheet.

2) For descriptions of programming methods, see Programming methods on page 40.

3) All SDIP32 packages are programmable using standard Development Kit. SO28 packag-
es can be programmed by adding the SO28 ZIF socket to the footprint provided at U12.
The ENPLAS product reference for the socket (not supplied with the kit) is ENPLAS
0TS28-1.27-04.

4
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4.1 Device programmer features

Figure 7: General eproming architecture

DC/DC converters ST/MDT1-DVP2 Main Board
External Power Supply 12V
5V=/1A o >
3.3v __>

PC HOST
PC Parallel Port Interface
I
VA~ Z

|
?7% -J 5V / 12V Power

<+«—— control

Ve .
Programming
<«— Data/ Control Bus

. SDIP32
Microcontrollersto
program: \

SDIP32 —

SO28 ZIF Programming
Sockets

g S0O28

4.2 Programming methods

421 ZIF sockets

The ST7MDT1-DVP2 development board is provided with a SDIP32 Zero
Insertion Force (ZIF) socket which allows the programming of SDIP32 packaged

MCuUs.
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4.2.2

Note:

4.3
Caution:

4

A footprint is also provided on the development board, for the optional mounting of
an SO28 ZIF socket. The reference number for the SO28 ZIF socket (not supplied
with the kit) is ENPLAS OTS28-1.27-04.

In situ programming

In addition to classic MCU programming using ZIF sockets, the ST7MDT1-DVP2
Development Kit is provided with an In Situ Programming (ISP) functionality. This
allows the user to program a target MCU mounted on an application board.

Only Group 1 target devices (see page 39) support the ISP functionality. In order to take
advantage of the ISP functionality, your application board must be designed to allow for in situ
programming.

Only target MCUs provided with a power supply of 5 V support the ISP functionality.

A provided 10-pin flat cable can be connected to the ISP connector (Ref: W2) at
one end, and to an ISP target connector which is contained on the application
board. Refer to the target device's datasheet for details on adding an ISP
connector to your application board.

The Windows Epromer fully supports the ISP functionality.

Device installation

Take care when placing the device into a socket so as not to damage the device or the board.
Never insert or remove devices when powered. Devices are powered only during read or write
operations.

Place the device into the
zero insertion force Align dot on device (pin 1) with the
(ZIF) socket mounted on triangle on board.
the board (location U6 | Target Device

for SDIP32 devices) >
with the erasure window

\VA
\ .
on top and pin 1 4

=

matching the triangle /
with a “1” beside it on /
the board. ZIE Socket Erasure window
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4.4 Starting the Windows Epromer

1 To start the Windows Epromer (Winee), select Start>ST7 Tools>Windows

Epromer.

The Epromer main window appears:

Click here to display the

epromer configuration window

" @ STMicroelectionfcs Windows E promer

File Edit Projegl Configure PBead Program Yerfy Miew Help

|

Area does not exist for that chip.

-] FI2[#]2] (221 2] Z]#]#]

Note that as long as the programming board
and the device to be programmed are not
specified, the display area is blank.

EEFPROM DOptions 3 Chip Information

Mo configuration restored, define configuration before using the epromer.

-
i@ <Unknown> |User-defined...
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4.5 Configuring the Epromer

Follow these steps:

1 In the main window tool bar, click the |I‘P?' icon to open the epromer
configuration dialog box:

Epromer Configuration E3 |

Select Hardware & Port | Select Chip |

Attached EPROMER hardware: Connected on :
ST7MDT1-KIT - LPT1
ST7MDTZ2-KIT =1 [LPT2
ST7MDT4-KIT Q

ST/MDT1-EPB

ST/MDTZ2-EPB

ST/MDT1-EPB2

ST/MDTZ-EPB2 b
ST/MDTA-EPB

ST/MDTS-EPB

ST/MDT1-DVP

ST/MDT1-DYP2 -

Epromer : STYMDT1-DVP2 Port:  LPT1
Chip: ST72101G1

1].4 I Cancel Apply Help

2 From the list, select the programming board for this ST7MDT1-DVP2
Development Kit:
ST7MDT1-DVP2.

3 Select the parallel port (LPT1 or LPT2) on your PC to which the development
board is connected.

4 Click the Select Chip tab to display the list of the devices that can be
programmed with this ST7ZMDT1-DVP2 Development Kit.

4
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Note:

44174

The list box shown below appears.

Select your
target device
with the ISP
option if you
wish to
program your
target device
using In Situ
Programming
(ISP)

Epromer Configuration
Select Hardware & Port | Select Chip |

Chip plugged in :

5T72124J4
ST7231442
ST72314J4
ST72314N2
ST72314N4
ST723344
ST72334N2
ST72334N4
ST72512R4
ST72511R6
ST72511R7
5T72511R9
ST72532R4
ST72124J2-15P
ST72124J4-15P
ST72314J2-15P
ST72314J4-15P

Epromer: STFMDT2-DVP2 Port:  LPT1
Chip: 5T72334)2
1].4 I Cancel Apply Help

5 From the list shown in the above dialog box, select the device to be
programmed:

Only devices displayed with an ISP suffix can be programmed using ISP functionality.

6 Click OK to confirm. The dialog box closes.

The memory mapping of the specified device now appears in the display area
of the main window. It is made up of “FFs”, as one may expect, since
programming has not taken place yet.

To view in turn the memory mapping of a selection of devices plugged in, open
the configuration window again, then the Select Chip list box, and click Apply.
The display area of the main window changes while the list box stays open, for
you to choose another chip if necessary.
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The name of the device to be programmed
is displayed here

' © STMicroelectronics W\ dows Epromer

File Edit Project ContN\ure Bead Program Merfy “iew Help

aoFooon

=[E] [BE] [&] Frrveisoz = [@[ee]e] [@[#]2] [#]#]2]

F¥F FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

00F010 FF FF FF FF FF FF FF FF FE ... ... . . ... . . .
O0FDZ0 F¥F FF FF FF FF FF FF FF FF ... .. .. .. .. .. ...
00F030 FF FF FF FF FF FF FF FF FE ... ... . . ... . . .
00F04 F¥F FF FF FF FF FF FF FF FF ... .. .. .. .. .. ...
00F 05 FE FF FF FF FF FF FF FF FE ... ... . ... . . .
0oFD f F FF FF FF FF FF FF FF . . . ... .. ....
000  Displey area

aoFn

OaFd

Details stored in the Epromer buffer for the
space corresponding to the currently selected tab [

F FF FF FF FF FF FF
pr FF FF FF FF FF FF FF FF FF FF FF FF FF FF .. ..............
F FF FF FF FF FF FF FF ..

TTMDT1 -DVP:

Hardware configuration set to <5

-
- fre]] n:Unknnuyu:\- User-defined \

‘| Information area

\

Progress bar

Origin of the
(progress of the current task g

display area contents

being executed by the Epromer) Cursor position
in the display area

7 Start your programming session.

For more information on how to use the Windows Epromer, click the Help

command in the main menu bar.

Note: Refer to Programming methods on page 40 for details on which programming methods can

be used with your target device.
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Note:

5.2

4

HARDWARE FEATURES

Link to PC

The ST7TMDT1-DVP2 development board communicates with your PC via the P2
connector connected to the PC parallel port (LPT1 or LPT2).

The parallel port of your PC should have been configured (in the BIOS settings) with either
the Centronics, EPP, ECP or bidirectional parallel port configurations.

Jumper and solder point descriptions

The following table lists jumpers and solder points located on the development kit
board, and whether they can be configured by the user, and if so, what they do.

Jumper name

User-
configurable?

Description of utility

ISP-SEL
(TP1)

NO

Use of this jumper could permanently damage the
development board. This jumper has been removed
from current versions of the ST7MDT1-DVP2.

ISP DRV PRG
(TP6)

Under very
specific
circumstances.

On older ST7TMDT1-DVP2 development kit boards,
you may need to use this jumper to perform an ISP
driver firmware patch as detailed in the application
note AN1363/0401, entitled Workaround to ISP
Mode Limitation in ST7MDT1-DVP2 and
ST7MDT2-DVP2.

DO NOT attempt to use this jumper for ISP mode
programming!

Use of this jumper is only supported following the
detailed instructions given in AN1363/0401,
available from ST’s website at http://mcu.st.com.

In currently released version of the development kit,
this jumper has been removed, as the ISP mode
limitation has been corrected.

JAM PROG
(TP7)

NO

Use of this jumper could permanently damage the
development board. This jumper has been removed
from current versions of the ST7MDT1-DVP2.

G1

YES

Soldering the two poles of this solder point together
allows you to connect the clock to the OSC_OUT pin
on the passive probe connector.

G2

YES

Soldering the two poles of this solder point together
allows you to power your application board using the
VDD pin in the passive probe connector (see Section
5.3.20n page 48)
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Power supply

Supplying the development kit

A plug-in power supply pack is supplied with the ST7TMDT1-DVP2 Development Kit
to be connected to the P1 male jack connector. This power supply must be plugged
into the appropriate AC source. Specific sales types indicate the corresponding
mains AC voltage supported:

Sales Type AC Mains Voltage Supported
ST7MDT1-DVP2/EU 220V
ST7MDT1-DVP2/UK 240V
ST7MDT1-DVP2/US 110V

Provided DC power specifications are as follows:

Voltage: 5V
Current: 1 A

A complementary power supply inlet (ref.: JP1) is provided with the same
specifications. When using this power supply, take care of the polarities marked
nearby the two-point connector.

Supplying the application board

You may supply your application board directly from the development board via the
VDD pin in the specific probe connector, after a solder spot has been placed in G2
on the development board. Refer to pin assignments given in Section 5.4 for the
location of the VDD pin on each passive probe type.

Note that this method of supplying power to your application board is not
recommended over an external application board power source.

Pin descriptions

You may connect an application board to the ST/MDT1-DVP2 development board
for evaluation or debugging in linked emulation mode. Signals are transmitted via a
passive probe to be plugged in the application board at the location of the
emulated device.

Table 4 on page 49 shows the pin assignment for the passive probe connector on
the application board.
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Table 4: SDIP32 passive probe pin assignments

Probe Pin No. |Pin Name/Description Probe Pin No. |Pin Name/Description
1 RESET 17 C2 Port
2 OSCIN (0OSC1) 18 C1 Port
3 0SCOUT! (0sc2) 19 CO Port
4 B7 Port 20 A7 Port
5 B6 Port 21 A6 Port
6 BS Port 22 A5 Port
7 B4 Port 23 A4 Port
8 Not used 24 Not used
9 Not used 25 Not used
10 B3 Port 26 A3 Port
11 B2 Port 27 A2 Port
12 B1 Port 28 Al Port
13 BO Port 29 A0 Port
14 C5 Port 30 Not used (VPPTEST)
15 C4 Port 31 VSS (Ground)
16 C3 Port 32 VDD?

1) The emulator clock is connected to OSCOUT only when a solder spot is

placed in G1 on the development board.

2) The emulator is only connected to VDD if a solder spot is placed in G2 on the
development board. The application voltage can be either 3.3 to 5V only.
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Table 5: SO28 passive probe pin assignments

Probe Pin No. |Pin Name/Description Probe Pin No. |Pin Name/Description
1 RESET 15 C2 Port
2 OSCIN (OSC1) 16 C1 Port
3 OSCOUT? (0SC2) 17 CO Port
4 B7 Port 18 A7 Port
5 B6 Port 19 A6 Port
6 BS Port 20 A5 Port
7 B4 Port 21 A4 Port
8 B3 Port 22 A3 Port
9 B2 Port 23 A2 Port
10 B1 Port 24 Al Port
11 BO Port 25 AO Port
12 C5 Port 26 Not used (VPPTEST)
13 C4 Port 27 VSS (Ground)
14 C3 Port 28 VvDD?2

1) The emulator clock is connected to OSCOUT only when a solder spot is

placed in G1 on the development board.

2) The emulator is only connected to VDD if a solder spot is placed in G2 on the
development board. The application voltage can be either 3.3 to 5V only.
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On-chip peripherals

You can configure certain on-chip peripherals in STVD7's MCU Configuration
dialog box (refer to Section 3.6 on page 22) so that the emulator accurately
emulates your target device.

The following options are available on all supported target devices:

Clock
You may choose the clock type (for example, on-board, external or on-chip) as a
microcontroller configuration option.

The clock types available can vary depending on the target device. Refer to Section 5.7.1 on
page 56 for an explanation of clock types available).

The development board is shipped with a 16-MHz (TTL) on-board clock.

You may also use an external clock (TTL-compatible, max. 16 MHz) whose signal
is supplied via the mini wrapping pin EXTCLK located on the board next to the
passive probe flat connector (ref.: TP26). For Group 1 MCU'’s you may also choose
an on-chip clock.

In normal mode (Miscellaneous Register slow mode bit=0), acceptable CLOCKIN
frequencies can take any value between 16 MHz and 250 kHz.

In slow mode (Miscellaneous Register slow mode bit = 1), the EXTCLK frequency
must take values between 16 Mhz and 8 Mhz.

Note that the board cannot operate with clock signals received from the application
board via the OSCIN pin of the probe. You must use the EXTCLK inlet instead.

However, the application board can use the development board clock via the
OSCOUT pin of the probe. In this case you must place a solder spot on G1 (see
Jumper and solder point descriptions on page 47).

Watchdog

This option allows you to choose whether the watchdog timer is enabled by
software or by hardware.

Refer to the datasheet for your ST7 MCU for more information on the watchdog
timer.

The following options are only available on the following microcontrollers:
ST72254G1/G2, ST72216G1, ST72215G2, ST7104G1/G2.
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MCU VDD

Allows you to set the supply voltage for the debugging session at either 5V or
3.3V.

LVD 5 Volts

Allows you to enable (ON) or disable (OFF) the LVD (Low Voltage Detection). This
option only works when MCU VDD is set to 5V. In this case, the selected low
voltage detection threshold will be 4.3 V.

Clock filter

When ON, the internal cell clock filter of the emulation chip is enabled. Refer to the
datasheet for your MCU for more information on the internal clock filter.

EXTIT

Allows you to specify to which port(s) external interrupts will be attributed.

e« ITO:PA/IT1:PB-PC means that external interruptions at level 0 (ITO) will
attributed to port A, while external interruptions at level 1 (IT1) will be attributed
to ports B and C.

« ITO:PA-PC/IT1:PB means that the external interruptions at level 0 (ITO) will be
attributed to ports A and C, while external interruptions at level 1 (IT1) will be
attributed to port B.

Halt and watchdog

There are two options: Reset and No Reset. If this option is set to Reset, when the
Watchdog is enabled and a Halt instruction is encountered in the executable code,
a chip reset will be performed. If this option is set to No Reset, no chip reset will be
performed.

Hardware events

Hardware Events are defined events used to control the trigger signal outputs and
trace buffer recording.

There are three types of hardware event:
e« Event On (EVT_ON): The address where the event begins.
« Event Off (EVT_OFF): The address where the event ends.

e Event Hit (EVT_HIT): The event is active for the cycles in which one particular
address is accessed.
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For information on how to insert hardware events, refer to the online help available
with the STVDY.

For more information on how to used hardware events to control the external
output trigger (TRIGOUT) signal or the trace buffer filtering, refer to Section 5.6.1
on page 53.

5.6.1 Trigger/trace settings

The Trigger/Trace Settings dialog box (shown below), allows you choose a variety
of options:

Trigger/Trace Settings

—Hardware Events Mode
EYT,OM EYT, OFF EWT HIT

Trace fiering enable & | | :—‘

— ; i
TRIGOUT Rize  TRIGOUT Fall TRIGOUT Pulse

Trace filkering dizable

Trace On Trace Off Trace on address
— TRIGIM Trace Owverflow
Break on TRIGIM _+_ r |7 Break on Trace Overflow r
Ok LCancel |

« Select between two hardware event modes: trace filtering enabled or trace
filtering disabled. In the first mode, the recording of the trace buffer is controlled
using the same hardware events as those used to control the signals from the
external output trigger. See below for details on the external output trigger,
TRIGOUT.

« Choose to enable the Break on TRIGIN option. For details on the input trigger,
TRIGIN, see below.

e« Choose to enable the Break on Trace Overflow option. With this option
enabled, once the trace buffer is full, the program is stopped.

You may access the Trigger/Trace Settings dialog box from the Main STVD7
Menu by selecting Tools>Trigger/Trace Settings, or by clicking the Trigger/Trace

Settings icon _{ in the Tools toolbar.
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External output trigger (TRIGOUT)

The ST7MDT1-DVP2 development board features a special outlet (called
TRIGOUT,) through which an external signal can be triggered out. The TRIGOUT
pin is located on the board next to the passive probe flat connector (Ref.:TP24).

From the Trigger/Trace Settings dialog box, you can choose the hardware event
mode for the external signal (EVT_OFF/EVT_ON or EVT_HIT).

Input trigger (TRIGIN)

The ST7MDT1-DVP2 Development Board provides a special inlet (TRIGIN,
Ref.:TP25) that can be used to transmit a signal to stop the execution of your
application upon the occurrence of an external event (Break on TRIGIN). The
Break on TRIGIN option is available in the Trigger/Trace Settings dialog box
shown above. If this option is selected, on reception of a rising edge signal from the
TRIGIN pin, the program is stopped after the execution of the current instruction.

A schematic diagram is shown below:

L

Fepu

Op Code Fetch |

—

TRIGIN

—

Application

TRIGIN active on rising edge

Monitor
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MDT1-DVP2 emulation features

Figure 8: Emulation architecture

oo

- Breakpoints settings
- User memory Mapping

definitions
- Trigger Out settings

User Application Area
- program source
- variables / stack

System Monitor Area
- variables / stack

System Monitor code

Flex10k10A
programming data
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5.7.1 Emulation functional limitations and discrepancies
Not all development kit features are available or applicable for all target MCUs.
Supported target MCUs are divided into two groups:
Group 1 (based on ST72C254) Group 2 (based on ST72251)
ST72254 G1/G2 ST72251 G1/G2
ST72216 G1 ST72212 G2
ST72215 G2 ST72213 G1
ST72104 G1/G2 ST72101 G1/G2
The following is a list of functional limitations and discrepancies applicable when
using the Development Kit as an emulator (as compared to the actual target device
features):
Emulation Target Device Limitation or Discrepanc
Function/Feature Group pancy
You are required to select the clock option for your
target device when using the development kit with
the STVDY (refer to page 51 for instructions on how
to choose clock options).
For target devices in Group 1, you can choose
between three clock options: external, on-board
or on-chip.
* The external option refers to a clock external to
the development board (for example, a clock on
CPU Clock the user application board), connected via the
o tiosg Groups 1 & 2 EXTCLK pin.
P e« The on-board option refers to the on-board 16
MHz clock generator provided on the
development board.
e« The on-chip option refers to the internal RC
oscillator of the CPU itself.
For devices in Group 2, you may only choose
between on-board and external clock options.
The External RC and xrd Resonator options are
not available on the MDT1-DVP2 development
board.
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Emulation
Function/Feature

Target Device
Group

Limitation or Discrepancy

Temperature
Tolerance

Groups 1 & 2

Independent of the target device used, the very
large temperature tolerance scope of the ST72254
target device (-40°C to +85°C) is not applicable to
the development board. The development board
has been designed to function at ambient
temperature.

Slow Mode

Groups 1 &2

Slow mode will not have the same significance for
devices in both groups.

For devices in Group 1, the setting of this bit
allows the use of another two bits to set the division
rate of the CPU clock.

For devices in Group 2, one bitin the
Miscellaneous Register implies the division by 32
of the internal CPU clock frequency.

For more information, refer to the definition of the
Miscellaneous Register in the target device
datasheet.

Low Voltage
Detection

Group 1

For those target devices in Group 1, the Low
Voltage Detection (LVD) feature is supported only
when the supply voltage is 5 V (refer to LVD

5 Wolts on page 52 for more details). It is
implemented using the on-board push button (see
Figure 4 on page 12) which causes the chip to
reset. Your application will be able to detect that the
reset was caused by LVD by reading the LVDRF bit
in the CRSR register.

Note that if the LVD push button is used with a
Group 2 target device, the chip will be reset, but the
reason for the reset will not be recorded in any
register.

Supply Voltage

Group 1

For target devices in Group 1, the development
board application supply voltage should take a
value of either 3.3 or 5V, as opposed to any
voltage in the 3 to 5.5 V range for the actual target
devices.

(The only allowable supply voltage for Group 2
devices is 5 V.)
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Emulation
Function/Feature

Target Device
Group

Limitation or Discrepancy

Analog to Digital
Converter

Group 2

For those devices in Group 2, the Analog to Digital
Converter cell will have a longer conversion time
in emulation than for the actual target device.

Ports A7, A5, A3,
A2, Al, AO

Group 2

While the Development Kit allows you to set a
Push/Pull configuration for these ports, this is not
a supported feature on actual Group 2 target
devices.

Stack Size

Group 2

The emulation chip’s stack is located between
addresses 0x100 and 0x17F. While those target
devices in Group 1 also have the stack in this same
location, the target devices in Group 2 have their
stack located between addresses 0x140 and
Ox17F.

This discrepancy between the emulation chip and
Group 2 target devices has the following
repercussions during an emulation/debugging
session:

After a “Stack Underflow” break, the stack pointer
(i.e. the SP register) will indicate the address 0x100
(and not 0x140 as would occur with the actual
target device).

After a “Stack Overflow” break, the stack pointer
(i.e. the SP register) will indicate the address
0x13F (and not Ox17F as would occur with the
actual target device).

Note that if a Stack Overflow break is not validated,
any overflow of the stack will erase user variables
(if any) situated between addresses 0x100 and
0x13F inclusive.
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This development board respects the EMC requirements of the European
guideline 89/336/EEC under the following conditions:

Any tester, equipment, or tool used at any production step or for any
manipulation of semi-conductor devices have its shield connected to ground.

All ferrites provided with the development kit must be attached as described in
the hardware installation instructions of the relevant user manual(s).

Your development board must be placed on a conductive table top, made of
steel or clean aluminumor covered by an antistatic surface (superficial

resistivity equal to or higher than 0.5 MQ/cmz), grounded through a ground
cable(conductive cable from protected equipment to ground isolated through a
1 MQ resistor placed in series).

All manipulation of finished goods be made at such a grounded worktable.

The worktable must be free of all non-antistatic plastic objects.

An antistatic floor covering grounded through a conductive ground cable (with
serial resistor between 0.9 and 1.5 MQ) should be used.

It is recommended that you wear an antistatic wrist or ankle strap, connected to
the antistatic floor covering or to the grounded equipment.

If no antistatic wrist or ankle strap is worn, before each manipulation of the
powered-on development board, you touch the surface of the grounded
worktable.

It is recommended that antistatic gloves or finger coats be worn.

It is recommended that nylon clothing be avoided while performing any
manipulation of parts.

59/74




Appendix A: EMC Conformity and Safety Requirements

ST7MDT1-DVP2 User Manual

60/74

4




ST7MDT1-DVP2 User Manual Appendix B: Troubleshooting

APPENDIX B: TROUBLESHOOTING

B.1 Identifying the Problem

IF...

THEN...

Error Message (when starting the
STVD7 for DVP):

“Connection Error (LPT1):
Interconnection failure. Verify your
input/output cable.”

Ensure that:

e The parallel cable is connected between the
development board and one of the PC’s parallel ports
(LPT1 or LPT2). Note that the use of switch boxes
between the parallel port connector of your PC and
the development board is not recommended.

e The development board is powered on.

* The parallel cable used is the one supplied with the kit
by STMicroelectronics.

e STVD7 and Windows Epromer are not running at the
same time. If this is the case then shut down both and
ensure that only one or the other is running at any one
time.

If none of the above items has been overlooked, this may
mean that your parallel port connection needs to be
reconfigured.

Please refer to Section B.2, below.

Error Message (during STVD7
session):

“Emulator power off has been
detected.”

Ensure that your development board is powered on and
shutdown and restart your STVD7 session.

ISP does not work.

Certain application board configurations may prevent
you from being able to program your target MCU using
ISP mode.

Ensure that:

e The target MCU mounted on your application board
has a power supply of 5 V.
* There is low capacitance on the MCU’s RESET pin.

If you still cannot get ISP to work using your DVP, consult
the application note AN1363/0401 entitled Workaround
to ISP Mode Limitation on the ST/MDT1-DVP2 and
ST7MDT2-DVP2 which can be found on ST's website at:

http://mcu.st.com

This application note describes how to download and
perform a software and hardware patch that will permit
you to use ISP programming even when you have high
capacitance on the RESET pin of your target device.

4
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Changing the Parallel Port Setup on Your PC

Under certain circumstances, you may receive the following error message:

“Connection Error (LPT1/LPT2): Interconnection failure. Verify your input/
output cable.”

This may mean that the setup of the LPT1 or LPT2 port on your PC is not
compatible with the ST7MDT1-DVP2 development board.

To set up the port correctly:
1 Shut down and restart your PC in order to enter the BIOS setup.

2 Follow the messages displayed on the screen and when prompted, press the
key required to enter the BIOS setup (usually a function key or the ESC key).

3 Select the parallel ports menu. (This may be listed under I/O ports.)

4 Change the Mode of the LPT port that you have connected the development
board to (i.e. either LPT1 or LPT2) to one of the following compatible modes,
according to the following table:

Operating System Compatible Parallel Port Modes
Windows 95 ECP, EPP, Bidirectional or Centronics
Windows 98 EPP, Bidirectional or Centronics

Windows NT4 ECP, EPP, Bidirectional or Centronics

5 Save your changes and exit the BIOS setup.

Running the Hardware Test

The Hardware Test in the STVD7 for DVP lets you check that your development
board is correctly connected, configured and working. You can test components of
the development board individually, or all at the same time.

If problems occur during debugging (such as bad debugger responses and
unexpected behavior), you should check for hardware problems using the
Hardware Test function, and if any are detected, contact your STMicroelectronics
sales representative (see Product Support on page 69).

You may open the Hardware Test dialog box by:

» selecting, from the Main Menu, Emulator>Hardware Test
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i

» clicking on the Hardware Test icon - in the Emulator toolbar.

Be cautious in performing a Hardware Test on the emulator while an application is open. The
opened application WILL BE corrupted by the hardware testing process. If you find that your
application has been corrupted, simply close the application, and reopen it.

Hardware Test E3 |

The Hardware
Test dialog box
shows a list of
different tests that
can be performed
on the
development
board.

Check the box of
each test that you
wish to perform
(they are all
checked by
default) and click
Apply to start the
hardware test.

aystern RAM memony check v ﬂ
gyztem BOM memon check v
emulation Bakd memony check v
contral Bék memon check v
EPLD load check v
break on opocode fetch check v
K
Apply Select All Unzelect Al
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The Hardware
tests will be
performed one by
one, and the
results
summarized in
the dialog box as
shown at right:

Hardware Test E3 |

ayztem Bak memon check ¥ Test OF, d

aystern ROM memaory check v Test OF,

emulation Bakd memony check v Test OF.

contral Bék memon check v Test OF.

EFLD load check v  TestDKE

break on opocode fetch check v On Going...
Test started ... ;I
4] _>I_I

Seleh Al [mzeleat gl [Fancel |
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APPENDIX C: GLOSSARY

Development Board

DIL

ECP

EEPROM

EPP

EPROM

4

The main component of the development kit, the development board consists
primarily of a CPU which is capable of emulating the family of MCUs supported by
the development kit, and a number of peripherals that allow you to perform
debugging and programming functions. The development board contains a parallel
port to communicate with your PC and so allow the running and debugging of
applications designed for your target MCU. There are TRIGIN, TRIGOUT and
Trace Probe pins to respectively input and output signals. There are also a variety
of means by which you can use the development board to program target MCU
devices: via the on-board SDIP32 socket, via the In Situ Programming (ISP) port,
and optionally, by installing a S028 programming socket.

Dual In Line. Designates a type of device package with two rows of pins for thru-
hole mounting. Sometimes also called DIP (Dual In-line Package).

Extended capabilities port communication standard.

Electrically Erasable Programmable Read-Only Memory. A non-volatile type of
memory that can be erased and reprogrammed by program instructions. Since no
special power supplies or ultra-violet light source is needed, the contents of this
kind of memory can be changed without removing the MCU from the application
system.

Enhanced parallel port communication standard.

Erasable Programmable Read-Only Memory. A non-volatile type of memory that
can be erased by exposure to an ultra-violet light source. MCUs that have EPROM
are easily recognized because the package has a quartz window to allow exposure
to the UV light. If the EPROM MCU is packaged in an opaque plastic package, itis
called a “one-time programmable” OTP MCU because there is ho way to expose
the EPROM to a UV light source.
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Footprint

LVD

ISP

MCU

oTP

Designates the dimensions of the location of a component on a printed circuit
board or in a socket. It depends on the number of pins, their size, type and
positioning. The footprint of each ST7 device is specified in the datasheet in the
section titled Package Mechanical Data. (Refer to the ST7 MCU FAMILY
DATABOOK or the datasheets provided on the “MCU on CD” CD-ROM).

Low Voltage Detection. This is a feature available on some of the ST7 MCUs
supported by the ST7TMDT1-DVP2 (i.e. those in Group 1—refer to Section 5.7.1 on
page 56). A LVD push button on the development board allows you to simulate
what occurs when the MCU detects that the supply voltage is below a given
threshold.

In Situ Programming. Provided you have an In Situ Programming connector on the
application board containing the target device, you can use the ST7TMDT1-DVP2
ISP functionality and the Windows Epromer to directly program the target device.
Note that not all ST7 MCUs support the ISP functionality. Refer to In situ
programming on page 41 for more details.

Microcontroller Unit. Otherwise referred to as the “target device” throughout this
manual. This is the core product (or family of products) for which the Development
Kit is designed to act as an emulator and programming tool. In general terms, an
MCU is a complete computer system, including a CPU, memory, a clock oscillator
and I/O on a single integrated circuit.

One Time Programmable. Also referred to as OTPROM (One Time Programmable
Read-Only Memory). A non-volatile type of memory that can be programmed but
cannot be erased. An OTP ROM is an EPROM MCU that is packaged in an
opaque plastic package—it is called a one-time programmable MCU because
there is no way to expose the EPROM to a UV light source.

Passive Probe

66/74

A printed card having connector pins that allow you to connect the ST7MDT1-
DVP2 to the MCU socket of the user application board. Using the passive probe
allows the development board to emulate a target device embedded in your
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application. The passive probe is connected to the development board by two flat
34-pin cables.

PC (Program Counter)
The program counter is the CPU register that holds the address of the next
instruction or operand that the CPU will use.

RC network

Resistor-capacitor network.

SO
Small outline. Designates a type of device package with two rows of pins for SMD
or socket mounting.

STVD7 (ST7 Visual Debug)

A graphic debugger software package that allows you to debug applications
destined for the ST7 family of MCUs, either using a built-in simulator function, the
MDT1-DVP Development Kit or an HDS Emulator.

Target Device
This is the ST7 device that you wish to use in your application, and which the
development kit will emulate for you.

User Application Board
Designates your application board. It should include a socket for inserting the ST7
device or the passive probe.

ZIF Socket

Zero Insertion Force Socket. This type of programming socket is mounted directly
on the development board. To program an MCU, you insert it into the appropriate
socket (i.e. the SDIP32 ZIF socket for SDIP32 packages, or, if installed, the SO28
ZIF socket for SO28 packages).
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ST7MDT1-DVP2 User Manual Product Support

PRODUCT SUPPORT

If you experience any problems with this product or if you need spare parts or
repair, contact the distributor or ST sales office where you purchased the product.

Getting prepared before you call

Collect the following information about the product before contacting ST or your

distributor:

1 Name of the company where you purchased the development kit.

2 Date of purchase.

3 Order Code: Refer to the side of your developmentkit box. The order code will
depend on the region for which it was ordered (i.e. the UK, Continental Europe
or the USA).

4 Serial Number: The serial number is located on a label on the
developmentboard.

5 Target Device: The sales type of the ST7 microcontroller you are using in your
development.

Contact list

Note:

4

For American and Canadian customers seeking technical support the US/Canada is split
in 3 territories. According to your area, contact the following sales office and ask to be
transferred to an 8-bit microcontroller Field Applications Engineer (FAE).

Canada and East Coast

STMicroelectronics

Lexington Corporate Center

10 Maguire Road, Building 1, 3rd floor
Lexington, MA 02421

Phone: 781-402-2650

Mid West

STMicroelectronics

1300 East Woodfield Road, Suite 410
Schaumburg, IL 60173

Phone: 847-517-1890
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West coast

STMicroelectronics, Inc.
30101 Agoura Court
Suite 118

Agoura Hills, CA 91301
Phone: 818-865-6850

Europe

France (33-1) 47407575
Germany (49-89) 460060
U.K. (44-1628) 890800

Asia/Pacific Region

Japan (81-3) 3280-4120
Hong-Kong (852) 2861 5700
Sydney (61-2) 9580 3811
Taipei (886-2) 2378-8088

Software updates

You can get software updates from the ST Internet web site http://mcu.st.com.
For information on firmware and hardware revisions, call your distributor or ST

using the contact list given above.

Hardware spare parts

70/74

Yamaichi sockets
You can order additional Yamaichi QFP sockets directly from Yamaichi at:

http://www.yamaichi.de/Pu/quad_flat_pack/spec/a21-ic149.htm
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